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1. [bookmark: _Toc440188758]Увод
 (
Office button
Quick Access Toolbar
Трака са командама 
(
Ribbon
)
)Microsoft Office PowerPoint 2007 је програм који представља део пакета Microsoft Office. Он је намењен креирању мултимедијалних презентација. Након покретања програма појављује се уобичајени изглед екрана који приказује Слика 1. Уместо сложеног система менија који је био присутан у верзији 2003, у верзији 2007 у горњем делу прозора налази се графичка трака са командама (Ribbon) у оквиру које се налазе картице са дугмадима и листама за одговарајућа подешавања. У горњем делу прозора налази се и дугме Office (Office button) и палета алатки Quick Access Toolbar на коју се може поставити готово свако дугме, пречица или команда која се често користи када се десним тастером миша притисне одговарајућа ставка и изабере команда Add to Quick Access Toolbar. 


 (
Слика 
1
 Изглед екрана након покретања програма
)[image: ] 

Инсталацијом одговарајућег додатка могуће је додати картицу са класичним изгледом менија која подсећа на изглед који је био присутан у претходној верзији програма (Слика 2). 
[image: ]
 (
Слика 
2
 Изглед горњег дела прозора програма са активираном картицом 
Menus
)
2. [bookmark: _Toc440188759]Office дугме (Office Button)
Кликом на Office дугме (Office Button) отвара се мени са основним командама за рад са документом (нпр. креирање нове презентације, отварање постојеће презентације, штампање) и листом недавно отвараних презентација.
[image: ][image: ] (
Слика 
3
 
Office 
дугме
)











 (
Слика 
4
 Изглед менија након притиска на 
Office 
дугме
)



	


2.1. [bookmark: _Toc440188760]Креирање нове презентације
[image: ]Office Button → New
 (
Слика 
5
 Позиција команде 
New
 
у падајућем менију 
Office 
дугмета
)

[image: ]Отвара се дијалог New presentation (Слика 6) где се избором Blank Presentation и притиском на Create креира нова празна презентација.
 (
Слика 
6
 Изглед дијалога 
New presentation
)
Нову презентацију могуће је креирати и комбинацијом тастера CTRL+N или притиском на иконицу у Quick Access Toolbar-у (Слика 7).
 (
Слика 
7
 Приказ иконице 
New 
у 
Quick Access Toolbar
-у
)[image: ]
2.2. [bookmark: _Toc440188761]Отварање постојеће презентације
Office Button → Open
 (
Слика 
8
 Позиција команде 
Open
 
у падајућем менију 
Office 
дугмета
)[image: ]
Отвара се дијалог Open (Слика 9) у коме се даље тражи путања до презентације коју треба отворити.
 (
Слика 
9
 Изглед дијалога 
Open
)[image: ]
[image: ]
 (
Слика 
10
 Приказ иконице 
Open 
у 
Quick Access Toolbar
-у
)Дијалогу Open могуће је приступити и комбинацијом тастера CTRL+О или притиском на иконицу у Quick Access Toolbar-у (Слика 10).

2.3. [bookmark: _Toc440188762]Затварање презентације
Office Button → Close
 (
Слика 
11
 Позиција команде 
Close
 
у падајућем менију 
Office 
дугмета
)[image: ]
Презентацију је могуће затворити и комбинацијом тастера CTRL+W или кликом на иконицу у Quick Access Toolbar-у (Слика 12).
 (
Слика 
12
 Приказ иконице 
Close 
у 
Quick Access Toolbar
-у
)[image: ]
[image: ][image: ]Затварање програма могуће је извршити комбинацијом тастера ALT+F4, кликом на Exit PowerPoint у оквиру падајућег менија Office дугмета или притиском на дугме „×“  у горњем десном углу прозора (Слика 13).
 (
а)
) (
б)
)
 (
Слика 
13
 а) Позиција команде 
Exit PowerPoint
 
у падајућем менију 
Office 
дугмета и б) Приказ дугмета за затварање апликације
)



2.4. [bookmark: _Toc440188763]Снимање презентације
Office Button → Save
 (
Слика 
14
 Позиција команде 
Save
 
у падајућем менију 
Office 
дугмета
)[image: ]
[image: ]Када се први пут снима документ, команда Save отвара дијалог прозор Save As (Слика 15) у оквиру кога се даје назив презентацији, врши избор типа датотеке и фасцикле у којој ће презентација бити сачувана. 
 (
Слика 
15
 Приказ дијалог прозора 
Save As
)
[image: ]	Снимање презентације могуће је извршити и комбинацијом тастера CTRL+S, као и кликом на иконицу у Quick Access Toolbar-у (Слика 16).
 (
Слика 
16
 Приказ иконице 
Save 
у 
Quick Access Toolbar
-у
)


Свака наредна примена опције „Save“ снима направљене измене у изворном документу. Уколико је потребно да се сачувају измене направљене у презентацији, без промене у изворном документу користи се опција „Save As“ тј. „Сачувај као...“ којом се прави нови документ. Ова опција се налази у падајућем менију Office дугмета (Слика 17).
 (
Слика 
17
 Позиција команде 
Save as
 
у падајућем менију 
Office 
дугмета
)[image: ]  

Типови презентација у PowerPoint-у 2007:
· .pptx – стандардни облик презентације (PowerPoint Presentation);
· .ppsx – директно емитовање (PowerPoint Show);
· .potx – шаблон (PowerPoint Template).



2.5. [bookmark: _Toc440188764]Шаблони (Templates)
2.5.1. [bookmark: _Toc440188765][image: ]Отварање постојећег шаблона
Office Button → New
 (
Слика 
18
 Позиција команде 
New
 
у падајућем менију 
Office 
дугмета
)
	Отвара се дијалог New presentation где се након избора картице Installed Templates из листе са леве стране даље бира жељени шаблон (Слика 19).
 (
Слика 
19
 Изглед дијалога 
New presentation 
са активираном картицом са инсталираним шаблонима (
Installed templates
)
)[image: ]



2.5.2. [bookmark: _Toc440188766]Снимање презентације као шаблона
[image: ]Office Button → Save As → Other Formats
 (
Слика 
20
 Позиција опције 
Other formats
 
у менију 
Office
 дугмета
)

[image: ]Након тога отвара се дијалог прозир Save As (Слика 21) где се из падајуће листе за шаблон презентације PowerPoint 2007 бира тип PowerPoint Template (*.potx). 
 (
Слика 
21
 Изглед падајуће листе из које се бира жељени тип датотеке у дијалогу 
Save As
 
)
2.6. [bookmark: _Toc440188767]Пребацивање презентације на CD
Office Button → Publish → Package for CD
[image: ]











 (
Слика 
22
 Позиција опције 
Package for CD
 у менију 
Office
 дугмета
)

Након избора ове опције отвара се дијалог Package for CD где се након притиска на Copy to CD врши снимање презентације на CD. 
 (
Слика 
23
 Изглед дијалога 
Package for CD
)[image: ]











2.7. [bookmark: _Toc440188768][image: ]Поглед пре штампања
Office Button → Print → Print Preview
 (
Слика 
24
 Позиција команде 
Print Preview
 у падајућем менију 
Office
 дугмета
)
2.8. [bookmark: _Toc440188769]Штампање презентације
Office Button → Print → Print
 (
Слика 
25
 Позиција команде 
Print 
у падајућем менију 
Office
 дугмета
)[image: ]	

Након одабира опције Print или коришћењем комбинације тастера CTRL+P отвара се дијалог прозор Print у коме се даље бира шта ће се штампати. Да би два или више слајдова било одштампано на једној страни неопходно је да се у делу Print what одабрати Handouts, а након тога у делу Slides per page одабрати жељени број слајдова по страни (Слика 26). 
 (
Слика 
26
 Изглед дијалог прозора 
Print
)[image: ]
2.9. [bookmark: _Toc440188770][image: ]Подешавања
Office Button → PowerPoint Options
 (
Слика 
27
 Позиција подешавања у менију 
Office
 
 дугмета
)

[image: ]









[image: ]

 (
Слика 
28
 Изглед дијалог прозора са напредним подешавањима
)

3. [bookmark: _Toc440188771]Quick Access Toolbar
Quick Access Toolbar je палета алатки које се често користе (Слика 29). Њу корисник може прилагодити својим потребама и додати команде које су му неопходне у свакодневном раду (Слика 30). 
 (
Слика 
29
 Изглед 
Quick Access Toolbar
-а и активираног падајућег менија 
Customize 
Quick Access Toolbar
 за његово подешавање
)[image: ]
 (
Слика 
30
 Приказ више опција за подешавање 
Quick Access Toolbar
-а која се добија након притиска на 
More Commands... 
у падајућем менију 
Customize 
Quick Access Toolbar
)[image: ]


3.1. [bookmark: _Toc440188772]Поништавање извршене операције
[image: ]Извршену операцију могуће је поништити комбинацијом тастера CTRL+Z или притиском на иконицу Undo у Quick Access Toolbar-у (Слика 31). 
4. [bookmark: _Toc440188773] (
Слика 
31
 Приказ иконице 
Undo
 
у
 
Quick Access Toolbar
-у.
)Картица Home
4.1. [bookmark: _Toc440188774]Премештање садржаја
Садржај је након обележавања могуће преместити коришћењем опције Cut („исеци“) из менија добијеног притиском на десни тастер миша или иконице у делу Clipboard картице Home или комбинацијом тастера на тастатури CTRL+X. Након тога се позиционирањем курсора „исечени“ садржај „лепи“ на жељено место коришћењем опције Paste из менија добијеног притиском на десни тастер миша или иконице у делу Clipboard картице Home или комбинацијом тастера на тастатури CTRL+V.
[image: ][image: ][image: ]



 (
Слика 
32
 Премештање садржаја
)
4.2. [bookmark: _Toc440188775]Копирање садржаја
Садржај је након обележавања могуће копирати коришћењем опције Copy из менија добијеног притиском на десни тастер миша или иконице у делу Clipboard картице Home или комбинацијом тастера на тастатури CTRL+C. Након тога се позиционирањем курсора ископирани садржај „лепи“ на жељено место коришћењем опције Paste из менија добијеног притиском на десни тастер миша или иконице у делу Clipboard картице Home или комбинацијом тастера на тастатури CTRL+V.


[image: ][image: ][image: ]
 (
Слика 
33
 Копирање садржаја
)




4.3. [bookmark: _Toc440188776]Додавање новог слајда
[image: ]Нови слајд могуће је додати притиском на иконицу New Slide у Slides (Слика 34) или коришћењем комбинације тастера CTRL+M, као и избором команде New Slide из падајућег менија који се добија притиском на жељени слајд десним тастером миша (Слика 35).

[image: ]
 (
Слика 
34
 Позиција иконице 
New Slide
 у картици 
Home
)




 (
Слика 
35
 Убацивање новог слајда притиском на десни тастер миша
) 

4.4. [bookmark: _Toc440188777]Дуплирање постојећег слајда
[image: ][image: ]Слајд је могуће дуплирати избором команде Duplicate Selected Slides у падајућем менију New Slide у картици Home (Слика 37) или комбинацијом тастера CTRL+D, као и избором команде Duplicate Slide из падајућег менија који се добија притиском на жељени слајд десним тастером миша (Слика 36).












 (
Слика 
36
 Дуплирање слајда из менија добијеног притиском на десни тастер миша
) (
Слика 
37
 Дуплирање слајда командом у картици 
Home
 
)

4.5. [bookmark: _Toc440188778]Брисање слајдова
[image: ]Слајд је могуће избрисати обележавањем жељеног слајда и поступањем на неки од следећих начина:
1) притисак на тастер DELETE на тастатури;
2) избор команде Delete у делу Slides у картици Home (Слика 38);
3)  (
Слика 
38
 Брисање слајда командом у картици 
Home
)избор команде Delete Slide из падајућег менија који се добија притиском на жељени слајд десним тастером миша (Слика 39).



[image: ]
 (
Слика 
39
 Брисање слајда из менија добијеног притиском на десни тастер миша
)		









4.6. [bookmark: _Toc440188779]Изглед слајдова
Изглед слајдова (Slide Layout) подешава се притиском на иконицу Layout у делу Slides картице Home (Слика 40).
 (
Слика 
40
 Подешавање изгледа слајда
)[image: ]

4.7. [bookmark: _Toc440188780]Форматирање фонта
Подешавања формата фонта (врста фонта, величина слова, подебљавање, подвлачење, боја слова...) налазе се у делу Font картице Home (Слика 41). Више подешавања могуће је добити притиском на стрелицу у доњем десном углу када се отвара дијалог прозор Font (Слика 42). Неким подешавањима је могуће приступити и обележавањем жељеног текста, а затим преласком стрелицом миша преко њега (Слика 43).
 (
Слика 
41
 Подешавања фонта у картици 
Home
)[image: ]





 (
Слика 
42
 Дијалог прозор 
Font
)[image: ]













[image: ]

 (
Слика 
43
 Опције којима је могуће приступити преласком стрелице миша преко обележеног текста
)

4.8. [bookmark: _Toc440188781]Форматирање параграфа
Формат параграфа, укључујући поравнање, набрајања и листе, размак између редова и смер текста подешавају се у делу Paragraph картице Home (Слика 44).
 (
Слика 
44
 Позиција дела 
Paragraph
 
у картици 
Home
 
)[image: ]	
Додатним подешавањима могуће је приступити притиском на стрелицу у доњем десном углу (Слика 45).
 (
Слика 
45
 Изглед дијалога 
Paragraph
)[image: ]
Неким подешавањима параграфа (поравнање, листе) могуће је приступити и обележавањем жељеног текста, а затим преласком стрелицом миша преко њега (Слика 46).
 (
Слика 
46
 Опције којима је могуће приступити преласком стрелице миша преко обележеног текста
)[image: ]

4.8.1. [bookmark: _Toc440188782]Рад са листама
Промена нивоа набрајања илустрована је на следећим сликама:
[image: ]

[image: ] (
Слика 
47
 Промена нивоа набрајања
)[image: ][image: ]

4.9. [bookmark: _Toc440188783]Претраживање
[image: ]Дијалог прозор за претраживање (Find) могуће је отворити коришћењем комбинације тастера CTRL+F или притиском на иконицу са двогледом Find у делу Editing картице Home (Слика 48). 
 (
Слика 
48
 Претраживање у презентацији
)
4.10. [bookmark: _Toc440188784]Замена
[image: ] (
Слика 
49
 Замена текста у презентацији
)Дијалог прозор за замену (Replace) могуће је отворити коришћењем комбинације тастера CTRL+H или притиском на иконицу Replace у делу Editing картице Home (Слика 49). 




5. [bookmark: _Toc440188785]Картица Insert
5.1. [bookmark: _Toc440188786]Додавање табеле
Убацивање табеле у презентациjу вршимо кликом на дугме Table → Insert Table у картици Insert (Слика 50). Кликом на Insert Table појављује се прозор у коме дефинишемо жељени број редова и колона у табели (Слика 51). 
	 (
Слика 
50
 Команда 
Insert Table
)[image: ]
	 (
Слика 
51
 Дијалог прозор 
Insert Table
)[image: ]

	
	 (
Слика 
52
 Положај иконице 
Insert Table 
у оквиру за садржај
)[image: ]


Дијалог прозор Insert Table (Слика 51) може се отворити и кликом на иконицу са знаком табеле на слајду пре убацивања неког другог садржаја у оквир за унос садржаја (Слика 52).
[image: ]Када се табела нацрта и обележи активирају се две нове картице (Тable Tools) за подешавање њеног дизајна (Design) и изгледа (Layout) (Слика 53). 
 (
Слика 
53
 Kартице за подешавање дизајна и изгледа табеле
)[image: ]

5.2. [bookmark: _Toc440188787]Додавање слике
Део Illustrations на картци Insert садржи опције за додавање слика. Дијалог прозор Insert Picture (Слика 54), у ком се врши избор жељене слике која се налази на диску, отвара се командом Insert → Illustrations → Picture (Слика 55) или кликом на иконицу на слајду пре убацивања неког другог садржаја у оквир за унос садржаја (Слика 56).
 (
Слика 
54
 Дијалог прозор 
Insert Picture
)[image: ]












[image: ]


 (
Слика 
55
 Додавање слике
)[image: ] (
Слика 
56
 Положај иконице за додавање слике
 
у оквиру за садржај
)

5.3. [bookmark: _Toc440188788]Додавање Clip Art-а
[image: ]Командом Insert → Illustrations → Clip Art отвара се картица из које се може изабрати неки цртеж, филм, звук или фотографија за илустрацију презентације (Слика 57).
 (
Слика 
57
 Додавање 
Clip Art-
a
)[image: ][image: ] 

5.4. [bookmark: _Toc440188789]Додавање фото-албума	
Коришћењем команде Insert → Illustrations → Photo album → New photo album могу се изабрати слике како би се направио фото-албум. 

 (
Слика 
58
 Додавање фото-албума
)[image: ]

 (
Слика 
59
 Дијалог прозор 
Photo Album
)[image: ]

5.5. [bookmark: _Toc440188790]Додавање дијаграма
Убацивањем различитих векторских облика из менија добијеног командом Insert → Illustrations → Shapes (Слика 60) могуће је нацртати различите дијаграме (Слика 61).
	[image: ]
 (
Слика 
60
 Додавање различитих облика
)
	 (
Слика 
61
 Нацртан дијаграм
)[image: ]


	
	 (
Слика 
62
 Цртање дијаграма из картице 
Home
)[image: ]


Различите облике могуће је додати и из картице Home где се такође налази дугме Shapes (Слика 62), а такође је могуће мењати боју и додавати различите ефекте (Quick Styles, Shape Fill, Shape Outline, Shape Effects). Још више опција за подешавање се налази у картици Drawing Tools Format која се активира када се обележи нацртан дијаграм (Слика 63).
 (
Слика 
63
 Изглед опција за подешавање формата нацртаног дијаграма
)[image: ]

5.6. [bookmark: _Toc440188791][image: ]Додавање блок листе
Различите блок листе се могу додати коришћењем команде Insert → Illustrations →  Smart Art (Слика 65) или кликом на иконицу у пољу за садржај (Слика 64).
[image: ] 


 (
Слика 
64
 Иконица за додавање блок листе
)
[image: ] (
Слика 
65
 Додавање блок листе
)








 (
Слика 
66
 Дијалог за избор блок листе
)
[image: ]

 (
Слика 
67
 Додавање блок листе
)

5.7. [bookmark: _Toc440188792]Додавање графикона
Графикон се може додати коришћењем команде Insret → Illustrations → Chart (Слика 68) или кликом на иконицу у пољу за унос садржаја (Слика 69).
 (
Слика 
68
 Положај команде за додавање графикона у картици 
Insert
)[image: ]

 (
Слика 
69
 Иконица за додавање графикона
)[image: ]







Након клика на ову иконицу отвара се дијалог прозор Insert Chart у коме се врши избор врсте графикона (Слика 70).
 (
Слика 
70
 Дијалог за избор врсте графикона
)[image: ]


[image: ]Након избора врсте графикона отвара се Microsoft Excel са пољима за унос података на основу којих се обликује графикон (Слика 71).













 (
Слика 
71
 Унос података за графикон
)
[image: ]Када је графикон обележен активирају се алатке за обликовање графикона (Chart Tools) (Слика 72).
 (
Слика 
72
 Алатке за обликовање графикона
)[image: ][image: ]

5.8. [bookmark: _Toc440188793]Додавање хиперлинка
На картици Insert се такође налази дугме за убацивање хиперлинка (Hyperlink) у делу Links. Хиперлинк се може убацити и коришћењем комбинације тастера CTRL+K.
 (
Слика 
73
 Додавање хиперлинка
)[image: ]






 (
Слика 
74
 Изглед дијалог прозора 
Insert Hyperlink
)[image: ]
















5.9. [bookmark: _Toc440188794]Додавање текстуалног поља
[image: ]Дугме Text Box на карици Insert у делу Text (Слика 75) нам омогућава да додамо текстуално поље тј. оквир у коме можемо написати неки текст. Текстуално поље се даље може преместити на било који део на слајду (Слика 76). 






 (
Слика 
75
 Дугме за додавање текстуалног поља
) 
[image: ]




 (
Слика 
76
 Изглед активног текстуалног поља на слајду
)

5.10. [bookmark: _Toc440188795]Додавање заглавља и подножја
[image: ]Заглавље и подножје могуће је уредити притиском на Header&Footer у делу Text картице Insert (Слика 77).

 (
Слика 
77
 Додавање заглавља и подножја
)

 (
Слика 
78
 Дијалог прозор за уређивање заглавља и подножја
)[image: ]











5.11. [bookmark: _Toc440188796]Додавање стилизованог текста (Word Art-a)
Стилизовани текст додаје се избором неког од стилова из падајућег менија који се активира кликом на дугме WordArt у делу Text картице Insert.
 (
Слика 
79
 Додавање 
WordArt-
а
)[image: ]








 (
Слика 
80
 Изглед стилизованог текста
)[image: ]






5.12. [bookmark: _Toc440188797]Додавање симбола
Симболи који се не налазе на тастатури могу се додати у текст избором из дијалог прозора Symbol (Слика 82) који се отвара притиском на иконицу у картици Insert (Слика 81).
[image: ]






 (
Слика 
81
 Иконица 
Symbol
 у картици 
Insert
)
 (
Слика 
82
 Дијалог за избор симбола
)[image: ]



















5.13. [bookmark: _Toc440188798]Додавање образаца
[image: ]Обрасци и различите математичке формуле се додају одабиром Microsoft Equation 3.0 из листе у дијалог прозору Insert Object (Слика 84) који се отвара кликом на дугме Object у картици Insert у делу Text (Слика 83).






 (
Слика 
83
 Дугме 
Object 
у картици 
Insert
)

 (
Слика 
84
 Изглед дијалога 
Insert Object
)[image: ]










 (
Слика 
85
 Прозор за унос 
обрасца
)[image: ]





5.14. [bookmark: _Toc440188799]Додавање мултимедијалног садржаја
Део Media Clips на картици Insert нам омогућава да додамо видео снимке и музику у презентацију. 
Insert → Media Clips → Movie
 (
Слика 
86
 Додавање видео снимка
)[image: ]






 (
Слика 
87
 Избор видео снимка
)[image: ] 

Insert → Media Clips → Sound
 (
Слика 
88
 Додавање звука
)[image: ]

 (
Слика 
89
 Избор звучног записа
)[image: ]

6. [bookmark: _Toc440188800]Картица Design
6.1. [bookmark: _Toc440188801]Дефинисање изгледа слајда
[image: ]Изглед слајда се дефинише помоћу дијалога Page Setup (Слика 91) који се отвара притиском на иконицу Page Setup која се налази у делу Page Setup картице Design (Слика 90).

 






 (
Слика 
90
 Позиција иконице 
Page Setup
)
[image: ]







 (
Слика 
91
 Изглед дијалога 
Page Setup
)
Оријенатацију слајда могуће је променити или у дијалог прозору Page Setup (Слика 91) или притиском на Slide Orientation у делу Page Setup картице Design (Слика 92).
 (
Слика 
92
 
Slide Orientation
 
у делу 
Page Setup
 картице 
Design
)[image: ]



	

6.2. [bookmark: _Toc440188802]Дизајн слајдова
Дизајн слајдова подешава се у делу Themes у картици Design (Слика 93).
 (
Слика 
93
 Део 
Themes 
у картици 
Design
)[image: ]





Могуће је изабрати неки од претходно дефинисаних дизајна, додати неку нову тему, као и подешавати ефекте, фонтове и боје у целој презентацији.
 (
Слика 
94
 Неке од опција за подешавање изгледа слајда
)[image: ][image: ] 


















6.3. [bookmark: _Toc440188803]Подешавање позадине слајда
Позадина слајда се може подешавати притиском десним тастером миша на појединачни слајд (Слика 95) и избором опције Format background чиме се отвара дијалог прозор Format background (Слика 96). Након избора жељене позадине, подешавање је могуће применити само на селектовани слајд или на све слајдове (Apply to All). 
	 (
Слика 
95
 Падајући мени добијен притиском на десни тастер миша
)[image: ]
	
	 (
Слика 
96
 Дијалог прозор 
Format Background
)[image: ]



[image: ]До истог дијалог прозора могуће је доћи и притиском на стрелицу у доњем десном углу дела Background картице Design (Слика 97) или притиском на Background Styles па на Format Background (Слика 98).
 (
Слика 
97
 Део 
Background
 
картице 
Design
)

[image: ]
 (
Слика 
98
 Могући стилови позадине и позиција опције 
Format Background
 
)












7. [bookmark: _Toc440188804]Картица Animations
7.1. [bookmark: _Toc440188805]Анимација садржаја слајда
Садржај слајдова могуће је посебно анимирати на различите начине користећи опцију Custom Animation из картице Animations (Слика 99). Могуће је изабрати више типова анимације, смер у коме ће се изабрани садржај кретати, начин на који ће се садржај појављивати и којом брзином (Слика 100).
[image: ]


 
 (
Слика 
99
 Дугме 
Custom Animation
 у картици 
Animations
)




[image: ][image: ][image: ] (
Слика 
100
 Опције за анимацију садржаја
)[image: ]   [image: ]














7.2. [bookmark: _Toc440188806]Подешавање начина појављивања слајда (транзиције)
Начин појављивања слајда подешава се у делу Transition to This Slide у картици Animations (Слика 101). Постоји веома велики избор транзиција (Слика 103), а могуће је подесити и тачно колико ће трајати емитовање сваког појединачног слајда (Слика 102).
 (
Слика 
101
 Подешавање транзиција
)[image: ]





[image: ]	
 (
Слика 
102
 Подешавање преласка на следећи слајд
)

 (
Слика 
103
 Могући начини појављивања слајда (транзиције)
)[image: ]














8. [bookmark: _Toc440188807]Картица Slide Show
8.1. [bookmark: _Toc440188808]Покретање презентације у Slide Show
Презентација се може емитовати од почетка притиском на дугме From Beginning у делу Start Slide Show или притиском на дугме F5 на тастатури. Такође, презентација се може емитовати и од слајда који је тренутно обележен притиском на дугме From Current Slide у делу Start Slide Show или помоћу комбинације тастера SHIFT+F5. 
 (
Слика 
104
 Дугмад за покретање извођења презентације
)[image: ]




[image: ]
	
 (
Слика 
105
 Иконица за покретање приказивања презентације од тренутног слајда
)

8.2. [bookmark: _Toc440188809]Подешавање времена трајања слајда
У делу Set up картице Slide Show могуће је помоћу опције Rehearse Timings извршити симулацију презентације у реалном времену и забележити време које се проведе приликом извођења слајдова (Слика 106).
 (
Слика 
106
 Алатка 
Rehearse Timings
)[image: ]











8.3. [bookmark: _Toc440188810]Додавање сумарног слајда

Да би се додао сумарни слајд у верзији 2007 потребно је инсталирати додатак који ће омогућити ову функцију. У том случају се у картици Slide Show додаје део Summary Slide (Слика 107). Да би се направио сумарни слајд неопходно је да се одабере Slide Sorter View у картици View, па да се затим обележе слајдови чији наслови треба да се налазе на сумарном слајду, па се прво притисне дугме Tag slides to include и на крају се притисне дугме Make summary slide (Слика 108).  
 (
Слика 
107
 Изглед додатка за сумарни слајд
)[image: ]






[image: ]






[image: ]
	





[image: ]






 (
Слика 
108
 Поступак додавања сумарног слајда
)[image: ]










 (
Слика 
109
 Изглед сумарног слајда
)[image: ]









9. [bookmark: _Toc440188811]Картица View
9.1. [bookmark: _Toc440188812]Преглед садржаја
[image: ]Различити погледи се могу изабрати у картици View у делу Presentation View: Нормалан поглед (Слика 110), Slide Sorter поглед (Слика 111), Notes Page поглед (Слика 112) и Slide Show поглед у коме се емитује презентација у режиму пуног екрана.










[image: ]


 (
Слика 
110
 Нормалан поглед
)
[image: ]










[image: ]


 (
Слика 
111
 
Slide sorter 
поглед
)

[image: ]

 (
Слика 
112
 
Notes Page 
поглед
)













9.2. [bookmark: _Toc440188813]Поглед на слајдове
Постоји умањен приказ слајдова и Outline приказ где се види само текст присутан на слајду.
	[image: ]
 (
Слика 
113
 Умањен приказ слајдова
)
	 (
Слика 
114
 
Outline 
приказ
)[image: ]


9.3. [bookmark: _Toc440188814]Мрежа и вођице
[image: ]Мрежа и вођице се укључују обележавањем поља Guidelines у делу Show/Hide  картице View.

 (
Слика 
115
 Укључивање мреже и вођица
)[image: ]

9.4. [bookmark: _Toc440188815]Мастер слајд
Мастер слајд даје иницијални изглед слајдовима и било која измена на њему аутоматски се рефлектује на остале слајдове. Команда Slide Master којом се укључују његова подешавања налази се у Presentation Views делу картице View (Слика 116).
 (
Слика 
116
 Команда 
Slide Master
)[image: ] 





 (
Слика 
117
 
Slide Master 
подешавања
)
[image: ]

9.5. [bookmark: _Toc440188816]Увеличавање и смањивање приказа
Увеличавање и смањивање приказа подешава се командом Zoom у картици View у одговарајућем дијалог прозору (Слика 118).
[image: ][image: ]
 (
Слика 
118
 Увеличавање и смањивање приказа
) 








10. [bookmark: _Toc440188817]    Помоћ

Помоћ за рад у програму позива се притиском на дугме F1 на тастатури или притиском на иконицу са знаком питања у горњем десном углу прозора (Слика 119).
 (
Слика 
119
 Положај иконице за помоћ
)[image: ] 

[image: ] (
Слика 
120
 Помоћ у програму
)[image: ][image: ] 	














11. [bookmark: _Toc440188818]    Извођење презентације
[image: ]При извођењу презентације могуће је „цртати оловком по слајду“. Оловка се активира коришћењем комбинације тастера CTRL+P или из менија добијеног притиском на десни тастер миша.
[image: ]
 (
Слика 
121
 Цртање оловком по слајду
)
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